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“Driving” Your Computer
by Diane Fahlbusch

President, ICON PC User Group, NY

W
e all know that one of the most essential components of our computer is the storage

drive. It’s is the home of your operating system, firmware, applications and those

precious files you have collected over time. Faster processors, more RAM … are

useless if there is nothing to pass through them. We now have tremendous options available

to us: larger capacity, faster RPMs, newer materials, faster connections, external drives and

thumb/flash drives. The more you know about them, the better you will be able to decide what

is right for you.
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Floppy Drives
Yes they still do exist!  But they have almost waved themselves goodbye. In their day they

were great, and became smaller. But as the capability of computers increased and technology

advanced, they just did not have the capacity, were too bulky and very fragile little things. But,

they are still designated as the A drive, and the standard “Save” icon.

Zip Drives and Jazz Drives
Yes, they still do exist!  These were inherently floppy drives on steroids to meet larger

capacity demands, as well as being able to function faster. But these are also stored to a

magnetic film, which will erode over time, and are subject to semi-severe conditions. So if you

still have anything you want from these, it is recommended that you transfer your data to a

newer format.

CD Rom Drives
These sounded the beginning of the end for floppy drives and their kin, as well as cassette

tapes and vinyl records. Writable CDs are very inexpensive now, and consist of various layers.

The top layer is actually a protective coating, which is why scratches to this layer may be able

to be repaired with Skip Disc, or something similar. The data is stored on a different layer.

There are plenty of these drives still around, and it’s not a bad idea to slap one into your tower

unit if you have room. This way you can burn out the CD only drive and save the:

CD/DVD Drive
This is the dual drive that is now standard on any computer, and very similar in physical

design to CDs. If you need to replace one, watch for read and write speeds, which are far faster

than the ones just 5-7 years ago, as well as any firmware updates you might need for faster

write speeds to work. Do not forget to watch the read/write speeds of the discs you buy, as well

as whether your drive can burn +R DVDs. Also watch for the “new” thing from just a few years

ago, dual layer. But of course the latest is:

Blue Ray Drive
An essential for REALLY large capacity discs or to watch blue-ray discs with high

definition graphics. Of course, if your monitor is not high definition or your computer’s video

card does not know what to do with HD files, you may just want to wait on this one. It’s still

very pricey – even the stand-alone units to connect to your HD TV.

Hard Disc Drives
The vast majority of storage drives available are still the good ol’ magnetic discs. The

original design of the rotating, rigid platters storing data magnetically by read/write heads

floating on a layer of pressurized air is still the same as it was from the 1960's, but the

recording density has increased dramatically. The platters themselves are not made of a

magnetic material. They are coated with a thin layer of magnetized material, which has

changed over the years. The platters are held together on a spindle, which requires very

careful placement to allow for just enough air between each platter as well as the read/write

heads. 

Disc drives also contain two electronic motors. One motor spins the platters at a specified

RPM. The faster the RPM, the faster the drive can access the data - and the greater the heat

output. The platters do have a special coating to resist thermal-induced magnetic breakdown,

but it is still very important to make sure that your cooling fans are working properly, and

more important to check or change your fans if you replace the factory installed drive with one

with a faster RPM.
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The second is called an actuator motor to control the read/write heads. If they no longer line

up correctly, they will not function properly. It is possible to reset the placement of the heads

if they are no longer lining up properly – but not easy. Of course, if your drive has experienced

a “Head Crash,” where the misplaced head has actually scraped along the surface of the disc,

those sections are destroyed forever. 

Your data is stored in digital magnetic format on the platters on disc drives. Once a brand

new hard disc drive has collected any information, it will never be the same as it was in its

pristine state – just as a magnet will always have some residual iron filings no matter how

hard you try to remove them. And of course another way to help prevent the loss of the data

is for the correct magnetization to be stored with some room to spare. But that concept of

“elbow room” shrinks as there is more data stored. One way to think about this is by

comparing the way some neighborhoods look today versus 25 years ago. So if your data was

originally being stored with plenty of space, you will wind up with fragmented files as that

space shrinks. 

Defragmenting your hard disc drive is one of those easy maintenance things to do to speed

up performance, because it moves related pieces of information near one another for faster

access. However, you can rewrite to a hard disc drive as long as the device is working properly.

Of course, there might be residual bits of magnetic charges left on that previously written

space which might corrupt your file. Hard disc drives seem sturdy because of their tough

protective casings and hard materials, but they are not made to withstand sudden shock, such

as being banged or dropped, especially when still spinning. 

Some notebook computers now come with an active hard drive protection that parks the

disc heads if the unit is dropped. Hard disc drives are also sensitive to power surges (including

static electricity), sudden loss of power, contamination within the enclosure, corrosion and

exposure to excessive heat or magnetic fields. Some recent studies seem to show that disc

drives maintained at somewhat colder temperatures do NOT outlast those at somewhat

warmer ones, as previously believed. All drives will experience normal “wear and tear.” 

Interestingly, your disc drives are like your car – it’s better for the engine if you take longer

trips instead of the short hops, or leaving it idling. One way to reduce the life of your drive is

by leaving the computer on, but in an idle state. It is better to shut the computer off when you

are not using it. Of course, excessive rebooting will also shorten the life of your disc drives, as

they have to spin up every time.

Solid State Drives
The newest data storage drive is the solid state drive, which is radically different than its

predecessor. These drives use microchips to store the data to free, programmable blocks and

do NOT contain any moving parts. Because of this they are quiet, physically smaller, use less

power to operate, run cooler, can tolerate greater altitudes and temperature ranges, tolerate

vibration, are not susceptible to magnetic fields, do not  require defragmenting (actually,

defragmenting adds wear for no benefit) and are less susceptible to sudden shock. (But that

does not mean that you should be playing handball with them!)  

Performance is most frequently tied to the type of memory used and the controller, an

embedded processor that works as a bridge between the computer’s electronics and its own, as

well as a number of other factors. They will typically use either non-volatile (NAND flash)

memory or volatile (DRAM) memory. The NAND flash based memory, while being slower than

its counterpart, has an advantage – it can retain information WITHOUT power. That is why

your camera cards and thumb/flash drives do not need a separate power supply. This memory

can be MLC (multi-level cell), or single-level cell, the latter of which is more reliable and faster,

but more expensive. Also, the NAND flash memory cannot directly overwrite a file. It must



The Rochester Computer Society, Inc. Monitor / May 2012 4

first rewrite the information to free programmable blocks of space, THEN it overwrites the

previous blocks. If data was encrypted with an encryption program NOT located on the drive

itself, the original data, can only be safely “wiped” by using a special “secure erase” program

on the drive.

Effectively, this means that your once secured information is insecure, unencrypted, and

accessible. And these blocks do have a limit of 1,000,000 to 2,000,000 write cycles (1,000 to

10,000 per cell) for MLC, and up to 5,000,000 write cycles (100,000 per cell) for SLC. This is

compensated for by “wear leveling” – writing to different sets of blocks each time and spreading

the usage out evenly. (Think of it as a little league coach who always rotates all of the players

in every game, but does a quick tidy-up at the end of the game.)  

This effectively means that you will eventually “use up” the memory. When that happens

the drive just stops working. Granted, it may take a many years, but it depends upon how

much you create, or re-create. The DRAM provides lightening fast data transfer, and does NOT

have a limit to the number of times programmable blocks can be written to. It also requires

an internal battery or capacitor or other power supply, and requires backup storage systems

to ensure preserving data if power is lost. These are most frequently used as internal drives

in netbooks and computers. Because nothing needs to spin during boot up or starting up

applications, these drives respond rapidly. Their read times are far less than hard disc drives,

again because there are no heads to search for the data. However, these drives do have certain

drawbacks.

For starters, solid state drives with DRAM are far more expensive, but the price is coming

down. Because of this, there really are not many large capacity solid state drives available. Be

wary that there are some of these drives are using a combination of NAND and DRAM.

Another consideration is the write speed. Less expensive models may not be providing much

faster write performance than hard disc drives, but will be impacted significantly by the

number of free programmable blocks. Solid state drives are really not the best choice for

operating systems that continually rewrite to the drives while in use, such as Windows. While

solid state drives CAN provide greater performance, be aware that you can only push the

information through as fast as your connection can handle. Having a USB3 device will not

increase the speed of data transfer if your computer’s connection is USB1. Write performance

is greatly reduced when using a SATA connection. Performance of DRAM drives will

deteriorate in time when there are no free programmable blocks left. Also, as previously

mentioned, DRAM requires constant power. So even though your computer is turned off, the

DRAM drive still requires power. 

Please always remember to make educated decisions about the products you select, and set

realistic expectations on any hardware you use.
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Windows 8: Ready or Not?
Q.  Now that Windows 8 has Windows 8 has not been released commercially yet, though the

Consumer Preview Edition made its debut on February 29th. As a card-carrying geek with

chronically nerdy tendencies, I have been using it since that time. Windows 8 introduces many

new features and constitutes a significant change from Windows A. I have a few concerns,

though overall I like it. My complete review can be read at http://bit.ly/yl3RBx.

Q.  I am thinking about buying a Kindle or Kindle Fire reader, in part because I would like to

read your eBooks, but I have a few questions first: What formats are supported by eReaders?

What is the typical battery life of an eReader been released, have you tried it? If so, what do

you think?

A.  Does using an eReader hurt one’s eyesight? Thanks, Mr. M.

Q. .TXT and .PDF files are supported by all eReaders, as are basic image files such as .GIF and

.JPG. Beyond these fundamental formats, supported formats vary depending on the eReader.

As far as the typical battery, displaying pages of a book in an eReader uses very little

power. The most power is used when turning pages. Battery life is normally listed as 7,000 to

8,000 page turns, which would constitute several weeks of heavy reading, or about 36 minutes

if you’re Evelyn Wood. 

Regarding any harm to one’s eyesight, according to my ophthal-mologist, Dr. Jerry

“Squinty” Anderson, absolutely not. In fact, com-pared to a computer screen, there is less

eyestrain with an eBook reader because it will generally have a higher resolution and refresh

rate resulting in the absence of screen flicker. 

Q.  I receive the following security warning when I open my Gmail: “Do you want to view only

the Web page content that was delivered to you securely?” How can I prevent this from

appearing? I’m using Internet Explorer, if that makes any difference.

A.  That type of warning is not emanating from Gmail, but rather from your browser. Gmail

itself has no strong feelings about what you view. It will be happy to display anything you

click.

You didn’t mention what version of Internet Explorer you’re using, so try this – and if the

wording isn’t precise for your version, it should be close enough that you can locate the

appropriate settings: Go to Tools > Internet Options > Security > Security tab > Custom Level

button.

In the Miscellaneous section, change Display Mixed Content to Enable, then save and exit.

That should take care of it. 

Q.  The status bar on my screen is about an inch and a quarter wide, and I do not know how

to make it smaller. Can you help?

A.  By “status bar,” I’m assuming that you mean the Taskbar – the large bar that appears

across the bottom of the screen. If so, that is designed to expand or contract, which can come

in handy. I have a very large monitor, for example, so I keep my Taskbar about three times

the normal size so I can see a multitude of open programs and windows. 



The Rochester Computer Society, Inc. Monitor / May 2012 6

To adjust the size of the Taskbar. First, right-click it and make sure it shows that it is

Unlocked. Then place your cursor on the top horizontal edge of the Taskbar until it (your

cursor, not the Taskbar) turns into a double-headed arrow. 

While pressing the left mouse button, slowly drag the bar down toward the bottom of the

screen and it will “collapse” incrementally, in steps or tiers, to the size you want it to be.

When you’re done, right-click and lock the Taskbar so it won’t move or change in the future.

Mr. Modem’s DME (Don’t Miss ‘Em) Sites of the Month

Airline On-Time Statistics
Who among us hasn’t had the experience of racing to the airport to catch a flight, only to get

there and wait, and wait, and wait, and wait… but for how long? If you’re flying into or out of

any airport in North America, you now have access to statistics that may help answer that

question. The Bureau of Transportation Statistics provides detailed information regarding

airline punctuality, or lack thereof, current through December 2011. 

http://1.usa.gov/aFON6k

Polar Inertia
Polar Inertia is a self-described “Journal of Nomadic and Popular Culture.” This unusual

online magazine is updated seasonally with visuals that record the ever-changing global

landscape. My only criticism is that the default font used on this site is too small and my

bifocals doth protest. If you experience the same problem, click View > Text Size (or your

browser’s equivalent wording), and increase the size of the display font.

www.polarinertia.com

Road Sign Math
A fun driving game that bored motorists can play to pass the time. Read the rules first so

you understand what you’re looking for, then start driving and try to find a road-sign equation

worth submitting to the official Web site. On the site itself, select a state and when a road

sign’s description appears, click the “Read more” link located below the description to view the

sign and its mathematical explanation.

www.roadsignmath.com

Mr. Modem’s technology-tips eBooks and award-winning weekly computer-help newsletter,

now in its 12th year of continuous publication, are available on www.MrModem.com

What the Heck Are Hiberfil and Pagefile
by Linda Gonse

Editor/Webmaster, Orange County PCUG, CA

O
ne day while purging unnecessary and unused files on my Windows XP computer, I

spotted two massive files on the C:\ drive that perplexed me. One was hiberfil.sys at

nearly 3.5 gigabytes! And, the other was pagefile.sys at 2 gigabytes!

I did not delete them right then and there. First, I checked them out on Google. As it turns

out, both of the system files serve a purpose. 

Hiberfil.sys is a file the system creates when the computer goes into hibernation mode.

Windows uses the file when it is turned back on. If you don’t need hibernation mode and want

to delete the file you need to turn the hibernation option off before Windows will allow you to

delete the file.

The file size depends largely on the size of active RAM in the computer as the contents of

the file are basically a RAM image. That explains why the file was so large. My computer has

4G of RAM — although it only recognizes 3.25 gigabytes.
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I couldn’t see a need to have hibernate enabled on my computer so I disabled it by

unchecking the Enable Hibernation box in Power Options in the Control Panel. (The procedure

for turning hibernation off is significantly different between Windows XP and Vista.)

The next time I rebooted, though, my UPS scolded me for not having hibernation enabled.

The UPS unit used that as storage space in case the power goes out and battery power has to

kick in. 

I was careful to research pagefile.sys before taking any kind of action that might

compromise it.

Good thing, too. Pagefile.sys is the virtual memory file Windows uses. Typically, when

installed, Windows sets the size of the file at around 1-1/2 times the physical memory size.

However, the size may vary depending on the amount of free disk space when the file is created

and other factors. The default size generally works fine but it can be changed. Windows uses

this file for its normal operation, but if you really need the space you can delete it after turning

the virtual memory option off. Just  be aware that this can cause extreme instability in

Windows — even causing it to stop working. Yikes!

Back in the old 3.11 Windows days, a file like this was called a swap file. Windows used the

hard disk space even then to simulate extra memory.  A swap file helped when printing large

documents, among other uses. 

Not surprisingly, experts advise leaving pagefile.sys alone and to look elsewhere for files

to delete!
From the February 2012 issue of  Nibbles and Bits newsletter of the Orange County PC Users Group, CA

.

Do Not Track Plus
Reviewed by Larry Mobbs

President, Computer Operators of Marysville and Port Huron, MI

A
new program offered free from Abine.com software allows you to block websites you visit

from tracking where you browse. Many sites, and Facebook.com is one of the worst,

want to track every site you visit so they can match up your preferences to the items

they want to display on you wall for advertisers.

In the software industry there is a movement to have the browsers include a plugin that

prevents this action but as of yet it is not ordered and may never be. Browser publishers may

take this on from their own volition but they will be pressured by advertisers not to.

One must remember that many sites depend on you or others visiting the links they place

on their pages in order to pay for the website. 

When you run Abine it puts a small icon in your browser and it displays a number with

each site you visit, telling you how many attempts are made to track your visit and what type

of tracking company is making the effort. They also keep a running grand total of how many

blocks they have made. In the first few days of my use on one machine they blocked 1600

attempts.

Installation following the quick download is painless and there is virtually no setup. While

writing this article I loaded Firefox, down-loaded the software, and ran it as a plugin.

This is required for each browser you use. After restarting Firefox I visited cnn.com and

Donottrack Plus reported blocking 13 attempts to track my browsing on their site.

The program came highly recommended by Cnet.com, which is here I read about it. It can

be downloaded from Abine.com.
From the March 2012 issue of COMP Communicator, newsletter of  Computer Operators of Marysville and

Port Huron, MI.
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Tablet or Laptop, a Popular Question
by Gregory West

APCUG Advisor, Region 6 & International VP of Sarnia Computer Users’ Group in Canada

U
nless you are a “hard core” computer gamer, you can now officially say goodbye to the

laptop. 

The day of computer frustration is coming to an end. The answer to pulling your hair

out as you are trying to figure out why the laptop is so hard to use is called: “touch pads.”

Recently, I was on a technology cruise out of Miami, where 400 plus geeks road the seas

and clicked on computers in various seminars. Wait, that’s not correct. It wasn’t computers

these everyday people were using. No, it was touch screen devices. Mostly iPads I must admit.

This too is strange as the group was 99.9% Windows users. The average age in the 400 plus

crowd was, shall I say, more than 50+. Most of them said they cannot believe the difference

and ease when they switched from a laptop or desktop to a tablet.

Most people on the tech cruise, who recently bought a tablet and still owned a lap-

top/desktop computer, said that they “hardly ever use their computer anymore.” The hot topic

on the ship was the app. People were constantly sharing newfound apps for their tablets.

So what makes these tablets so popular? Price, ease of use, two click downloads for

software, portability, and low price is enticing laptop /desktop are just a few of the factors

enticing people to switch. Here are some tips when shopping for a tablet:

Test drive several. Ask friends who own them what they suggest. Do online searches for

reviews.

Decide what exactly you are going to use it for then decide on the size. I wouldn’t worry too

much about the hard drive size as most of what we do on computer is heading to the cloud and

soon you won’t need software programs for your devices.

Make sure the tablet of choice has a USB slot for thumb drives, cameras, and other such

devices. ITworld.com suggests “Decide on the operating system. The three main choices these

days are iOS, Android, or Blackberry Tablet OS. Do a bit of research on all three and pick the

one that will work the best for you.” 

One final word ... most people will tell you once they bought tablets their other computers

became lonely. Just ask anyone who owns a tablet and they’ll tell you they “hardly use” their

computers anymore because the tablet is “so much easier to use and less hassle.”

Forester.com researchers predict “Tablets will cannibalize netbooks and outsell them

starting in 2012. In 2015, 23% of all PCs sold to consumers in the US will be tablets.”  

Happy hunting.
Courtesy of APCUG.

Thank You Mr. Kilby and Mr. Noyce!
by Bill James

Editor / Webmaster, Computer Club of Oklahoma City

W
e are seeing dramatic shifts as our planet becomes smarter. These shifts are changing

the way the world works. Cities are becoming smarter by transforming traffic

systems, water systems, security – every possible form of municipal infrastructure.

Business process is evolving across every industry – banking, trading, manufacturing. And

we’re seeing changes in the way people live, enjoying advancements ranging from reduced

congestion and pollution to new ways to communicate and collaborate. Every aspect of life is

benefitting from the instrumentation, interconnection and infusion of intelligence into the

systems of the world. 
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Nothing is changing more than information technology: the way it’s accessed, the way it’s

applied, and the way it’s designed. The opportunities for innovation have never been greater.

Enterprises in every industry can use breakthroughs in technology to create new business

models, find new ways of delivering technology-based services, and generate new insights from

IT to fuel innovation and dramatically improve the economics of IT. New technology

innovations signal that we are entering a new era of computing – smarter computing – the era

of insight for discovery.  

“Who invented the computer?” is not a question with a simple answer. The real answer is

that many inventors contributed to the history of computers and that a computer is a complex

piece of machinery made up of many parts, each of which can be considered a separate

invention.

But it is no question how computers have changed our personal lives in the last 30 years.

I was in grade school during the days of the ‘Big Chief’ tablet and a No. 2 pencil. I also had a

metal quill pen and ink bottle. It was not until I was in the fourth  grade that I saw and used

a ballpoint pen. Handheld calculators were unknown and manual typewriters were still being

used well after I left college in the late 60s.  

My first exposure to the so-called PC was in 1980 when one was placed in my office. Prior

to the introduction to computers into offices, they were only found in huge air conditioned

rooms. They computed in batch cycles which took hours, nothing was instantaneous.

Who knew that one day computers would find their way into our homes, our cars and our

pockets and that we would have any request for information instantly.

I do not believe any single object has been so pervasive into our daily lives. To many the

computer is a blessing and to others it is a curse. Who knew that you could own a 40,000 book

library the size of one book or you could call anyone around the world with the punch of a

button. Who know that the Internet would allow access to entertainment, communicate and

share information with your family and friends? We can do shopping, banking and bill

payment from the comfort of our homes.

As with other appliances, computers have allowed us to evolve. Refrigeration allowed us

to shop less; television gave us a window to the world and microwaves allowed us to prepare

foods faster. These are just a few of devices that depend on a computer to function.

In the old days computers were big machines full of electron tubes. As technology

progressed, the advent of transistors reduced the size of the machines. I also grow up in a time

where radios were large boxes and not portable. The invention of transistors allowed the

making of a smaller radio. As transistors were introduced into computers it allowed computers

to become smaller. Often these may have been what would be referred to as hybrid devices –

a mix of tubes and transistors. It was not until the invention of the integrated circuit do we

begin to see miniaturization of the devices we use today. Some circuits can fit on the head of

a pin.

Today the smallest laptop computers have more computing power than computers of

yesteryear. To quote the CEO of IBM Sam Palmisano, “As our planet becomes instrumented,

interconnected, and intelligent, the computing model is evolving to support it.”

So who are Jack and Robert?

Jack Kilby, an engineer with a background in ceramic-based silk screen circuit boards and

transistor-based hearing aids, started working for Texas Instruments in 1958. A year earlier,

research engineer Robert Noyce had co-founded the Fairchild Semiconductor Corporation.

From 1958 to 1959, both electrical engineers were working on an answer to the same dilemma:

how to make more of less. And they did succeed.
From the February 2012 issue of  eMonitor, newsletter of the Computer Club of Oklahoma City, OK.
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The Trouble with Terabytes
by Diane Fahlbusch

President, ICON PC User Group, NY

T
echnological advances, different materials and cost efficient manufacturing have made

it possible for computers to leap from standard 20 GB hard drives of a decade ago and

the 200+ GB drives of yesterday to breaking through the gigabyte ceiling affordably in

a relatively short period of time. Now having a 1 terabyte drive is passé as 2 TB, 3 TB, and

even 4 TB drives are becoming commonplace. However, there are some things to be aware of

before making the leap. No, I will NOT wax poetic about my personal opinion of larger drives,

including the “Scarlet O’Hara” mindset of maintenance, indiscriminate saving of files, and the

time for security scans. (For that you can read “The Lurking Dangers of Larger Hard Drives”

in the June, 2010 issue of The ICON Graphic.)  Instead, you will need to consider whether your

current computer actually knows what to do with all that storage space.

Not so long ago almost all computer operating systems used the partitioning scheme called

the “Master Boot Record” (MBR). Unfortu-nately, the computer will not be able to recognize

anything over 2.2 TB. So that larger drive can be installed, but the additional storage space

will be useless. The MBR scheme is common on all Windows operating systems through

Windows XP, as well as other operating systems from that time period. Windows Vista and the

Mac OS X Leopard ushered in the new GUID partition table (GPT) which allows them to

recognize the larger drives. Windows 7 and Vista users can use the larger drives as

SECONDARY drive without worrying about whether it is a 32 bit or 64 bit version. 

But for anything larger than a 2 TB drive to be used as the primary drive, the computer

must be running the 64 bit version of Windows 7 or Vista. The systems boot-up firmware must

be checked as well. There are many computers using a newer operating system and the GPT

partition system, but still using the BIOS firmware. This will need to be updated to the new

UEFI firmware, which has become the new industry standard. Check with the terabyte drive

manufacturer to see if they offer a firmware update. Of course that updated firmware is useless

if the motherboard cannot run the firmware, so again, check with the manufacturer’s

specifications. Some will work, but you must use a different connection, such as the PCI-

Express card slot.

Most newly manufactured computers ARE equipped with 64 bit operating systems, the

GPT partition system and UEFI boot-up firmware. So if you are thinking about running amok

in terabyte land, these are some things to know about before upgrading, or buying that new

computer. Remember newnewnewnew just means that it has not been used by anyone – it does not

necessarily mean that it has the latest technology.
Courtesy APCUG.

Free Hard Drive Cleaners Remove
 Junk Files, Free Up Space

by Ira Wilsker

I
t never amazes me anymore when I try and help people having computer problems, often

performance related, and find that their hard drives are so badly cluttered with useless

garbage that hard drive performance is seriously degraded. While there are many potential

causes of poor computer performance, one of the easiest problems to detect and remedy is hard

drive clutter.

Our computers are constantly reading and writing data, often creating massive amounts

of temporary files that serve no useful purpose after a very short period of time, or after the
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program is closed.  Browsers use cache files as temporary storage, where web pages, images,

and other web-based information is temporarily stored.  After programs are installed, there

are often sizeable temporary files left on the hard drive that serve absolutely no purpose. The

frequent Windows updates downloaded from Microsoft, are usually very large files, often

writing huge temporary files on the hard drive, causing littering of our precious hard drive

space. It is not at all uncommon for users to literally have several gigabytes of useless garbage

occupying space on a device purchased by the user, which wastes time and money, as well as

possibly degrading computer performance.

One of the most common and most widely used types of utilities available are programs

that will remove the useless files from a hard drive. By far, the single most popular hard drive

cleaner is Piriform’s CCleaner (www.piriform.com/ccleaner), which has had over 100 million

copies downloaded, and has versions for both PCs and Macs, as well as a portable version. The

same fully featured program is available as a “free for personal use” desktop and portable

version (no support), an identical “Professional” version ($25 with priority technical support),

a “Business Edition” ($35 with business grade technical support), and a “Network Professional

Edition” with pricing based on the number of workstations.

The user can selectively choose which items to clean from the hard drive, but at a minimum

(for those who want to be especially safe and not concerned with possibly deleting useful files)

the user should select to clean browser temporary internet files (cache), recycle bin, temporary

system files, memory dumps, and old prefetch data; other items can be selected from both the

Windows and Applications tabs. CCleaner will perform a fast scan of the hard drive, disclosing

whatever files are selected for removal. If the user is satisfied with deleting the selected files,

clicking the “Run Cleaner” button will complete the cleaning process. As a general rule, I

personally choose not to delete internet cookies (most are harmless or necessary, and I use

security software to detect and remove risky cookies), browsing history, passwords, download

history, and other possibly useful internet content.

CCleaner also has other useful features, listed as icons on the left margin, and includes a

decent registry cleaner, a series of system tools including a startup manager, uninstall utility,

system restore, and a drive wiper which can securely overwrite sensitive data making it

difficult to recover.

While CCleaner is an extremely popular drive cleaning utility, there are hundreds of other

programs whose useless and temporary files are not cleaned by CCleaner; a free third-party

utility, CCEnhancer (singularlabs.com/software/ccenhancer), works as a plug-in to CCleaner,

identifies the software installed on the computer, and if available, adds those software products

to the list to be cleaned by CCleaner.

The same publisher that produces CCEnhancer also produces a complete, free, cleaning

utility, System Ninja (singularlabs.com /software/system-ninja), which is a direct competitor

to CCleaner, having many of the same functions and features as its larger competitor. In my

experience, while it is not quite as fast as CCleaner in scanning the hard drive, the System

Ninja “Junk Scanner” performs a more thorough scan for useless files, without the need for any

plugins (though two are available for specialized purposes). System Ninja also includes a

“System Tools” feature which incorporates a startup manager, process manager (shows what

is running, and can stop any unwanted programs), and a “FileAnalyzer” which can display

detailed information on any selected file. The “PC Analysis” function provides the user with

very detailed information on the computer’s hardware and operating system. System Ninja

bills itself as, “100% Freeware, 100% Safe; System Ninja is provided absolutely free of charge,

with no strings attached. It is also 100% free from Viruses, Malware, Spyware, and all that

other unwanted junk. We do not package any toolbars with System Ninja, nor do we use it to
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display ads or popups.”

A third cleaning utility which also has a large and loyal following is Wise Disk Cleaner –

Free Edition (wisecleaner.com/wisedisk leanerfree .html). Wise Disk Cleaner – Free touts that

it is “ ... the only 5-star disk cleaner rated by CNET editor.”

Unlike some of the other freeware drive cleaner that offer no or minimal technical support

“Wise Disk Cleaner Free provides lifetime free update service and Unlimited Free technical

support. In addition, it also provides more and more language packs for worldwide users”. Wise

Disk Cleaner is one of the easiest cleaners to use, offering a simple interface. The first option

is listed under the “Common Cleaner” tab, which will detect and remove the most common

forms of junk files from a hard drive, including obsolete and useless Windows system files, old

internet files, useless multimedia files, and the debris left by Windows components and other

program files. Other tabbed options include an “Advanced Cleaner” with additional cleaning

options, and a “Slimming System” feature which cleans the operating system of junk files.

About the only negative characteristic of the Free version of Wise Disk Cleaner is that it

is advertiser supported, not an evil enterprise, but something that the user should be aware

of; the authors need to be compensated for their work, and the free version does it with

advertising and related activities. According to the download website Major Geeks

(majorgeeks.com/Wise_Disk_Cleaner_d5436.html) “This program is advertising supported and

may offer to install third party programs that are not required for the program to run. These

may include a toolbar, changing your homepage, default search engine or other third party

programs. Please watch the installation carefully to opt out.” Unless you want any of these

advertising services and activities, be sure to uncheck the appropriate boxes during the

installation process when these items are offered.

I have all three of these hard drive cleaners installed on my computers, and rotate through

them periodically to ensure that my hard drive is clean of useless clutter. For those who like

to defragment their hard drives, removing these useless files prior to defragging will speed up

the defrag process, leaving much more usable space on the hard drive. If you ever get errors

that you are low on virtual memory (hard drive used as additional memory) or notice degraded

performance, try cleaning your hard drive with one of these three free utilities as a first step.

WEBSITES:

http://www.piriform.com/ccleaner

http://www.piriform.com/ccleaner/download/portable

http://singularlabs.com/software/system-ninja/

http://singularlabs.com/software/ccenhancer/

http://wisecleaner.com/wisediskcleanerfree.html

Microsoft’s Free Fix it Center Fixes
 Many Windows Problems

by Ira Wilsker

S
ome time ago, I wrote about an early beta (pre-release) version of Microsoft’s free Mr.

Fixit utility. With the early beta test now closed, I am happy to report that Mr. Fixit is

alive and well, and offering many times more free fixes than it did when I first reviewed

it. Mr. Fixit is now the character or avatar for the Microsoft Fix it Center, which offers

automated fixes for Microsoft products online, typically by downloading and installing a specific

problem centered client to the PC. According to Microsoft, “Fix it Center finds and fixes many

common PC and device problems automatically. It also helps prevent new problems by

proactively checking for known issues and installing updates. Fix it Center helps to consolidate
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the many steps of diagnosing and repairing a problem into an automated tool that does the

work for you.”

Mr. Fixit and the Fix it Center, available online at support.microsoft .com/fixit, has an

interesting motto that simply describes its functions that can repair many common Windows

problems; Easy, Relevant, and Be In Control. In terms of being easy, Microsoft say, “Microsoft

Fix it Center makes getting support easier than ever, with tools that help solve the issues you

have now and prevent new ones.” Mr. Fixit is easy to install and run, fully automated, and

provides some degree of preventive care. In terms of being relevant, “Microsoft Fix it Center

personalizes solutions for your device, showing you only what pertains to your hardware and

software.” The phrase “Be in Control” is appropriate because Mr. Fixit provides the user with

a simple method to stay in control of the maintenance of the computer by allowing the user to

customize settings (choose the level of automation), manage multiple devices, and enable

simple record keeping of all updates and repairs made on each device.

The online component of the Fix it Center (support.microsoft.com /fixit) allows the user to

optionally select a problem area labeled “1 Select a problem area (optional)” displaying a group

of eight large icons labeled Top Solutions, Windows, Internet Explorer, Windows Media Player,

Entertainment (Xbox 360 type icon, covers the Xbox, Zune, and Windows Phone), Office (Excel,

Word, PowerPoint, Outlook, Info path, Live Meeting, and project), and Other (SharePoint,

Exchange, SQL Server, Streets and Trips, and several other Microsoft products). Clicking on

one of the eight icons opens a context sensitive window “2 - What are you trying to do?” In this

window is listed many of the common problems faced by windows users; clicking on one of the

items open a second selection window on its right, offering a more detailed list of issues or

devices that are relevant to the original selection. Below that pair of windows are several

possible fixes, listed as “3 View or run solutions for (your chosen problem).” In that window is

a selection of “Run Now” buttons, each linked to a context sensitive solution. Clicking on the

appropriate Run Now button executes a file that contains the likely fixes for the selected

problem, repairs any damaged, missing or corrupted files and registry entries, displays results

and possible additional fixes, and then quietly exits.

Since I have been having periodic issues with the Windows Media Player on this Windows

7-64 computer, I tried the Fix it Center fix for Media Player problems. It downloaded a small

client (339k), loaded a “Troubleshooter,” explained what it would try to do and the steps that

it will take in order to rectify the problem, and gave me the option of allowing it to identify and

repair the problems automatically (recom-mended), or allow me to choose the fixes. I chose the

recommended option, and the troubleshooter ran, detecting the problems. After the first

attempt to repair my Media Player, I was given the choice to reset my Media Player and

libraries, or do nothing; I chose to reset it. In my particular case, the Fix it Center was able to

successfully reset my Windows media player and its scripting activities, but was unable to

repair the Media Player Library. I was then asked to load the problem program, Windows

Media Player, and asked if Mr. Fixit had success-fully resolved my problem; it did not, but

offered some additional possible solutions.

One of the most common irritants faced by many PC users is that their computer is running

sluggishly, and appears to be much slower than when new. While there are many possible

reasons for this degraded performance, the Fix it Center offers some possible automated fixes

for this dilemma. From the Fix it Center main webpage (support .microsoft.com/fixit), click on

the Windows button, and then in window #2, select “Fix performance, errors, or crashes.” In

the right window, select “Slow performance, startup, shut down, or memory.” In window #3,

select the Run Now button adjacent to,” Fix Windows system performance problems on slow

Windows computers; automatically troubleshoot and repair Windows performance problems.
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Improve, optimize and speed up Windows computers and make slow running PCs faster.” That

will initiate the downloading of another small 339k client that offers performance improvement

diagnostics and solutions. Accept the license terms, and the performance “Fix it” client utility

will be installed. Either allow it to detect and fix problems automatically (recommended by

default), or let it detect performance problems and then you can select from a menu of possible

fixes. On my desktop computer the only performance issue that it detected, which I chose to

intentionally not repair, was that I had several programs loaded at boot.

There are hundreds, if not thousands of possible Windows fixes freely available from the

Fix it Center, and it has become my first choice when looking for a fix for Windows problems.

The Fix it Center detects the operating system on the computer (Windows 7, Vista, or XP), and

displays appropriate fixes explicitly for that operating system and whatever Microsoft product

is connected or installed on that computer.

Whenever a PC user encounters what may be a Microsoft related problem, the Fix it Center

would be an appropriate first choice to check for a possible solution. The Fix it Center utilities

may not just identify the problem (as well as other related problems unknown to the user), but

may possibly fix the problems as well.]

WEBSITES:

http://support.microsoft.com/fixit/

http://fixitcenter.support.microsoft.com/Portal

http://fixitcenter.support.microsoft.com/Portal/Features

Streaming Media
by John Somers

Interactive Computer Owners Network, MO

S
treaming” is listening to music, watching a TV program or movie as it is being delivered

to you over the internet. The technology is very difficult (say geek intensive) but it works

and well for many of us and is an alternative to cable or satellite delivery of the signals.

Several years ago Bill Gates said famously or infamously, “The internet, who needs it!” And

this year Steve Jobs said, “We are in the post PC era.” More and more people use the internet

and communicate over smart phones and tablets and do not use computers as we know them.

Smart phones and tablets are indeed computers but without a large monitor and a keyboard.

Streaming of music began in the mid to late 90s as personal computers became more

powerful and the networks connecting them became capable of supporting faster data rates.

As these trends continued, it became possible to stream TV programs and eventually movies.

This is different from buying or renting a TV program or movie which is downloaded to your

computer for you to watch at your convenience. The driving force is us — we do not want to be

tethered to the radio or TV stations schedule or have to go to a movie theatre or to a store to

buy a DVD. We want to watch what we want when we want it. Time shifting has become more

sophisticated compared to the days of the VHS or Beta (remember them?) Netflix recommends

5 Mb/s or more for the best audio and video experience.

First, the sources. (And I will write only about common and legal methods/sources of

content, not about illegal/pirated sources of content — mostly or completely off-shore now and

clearly violating copyright.)

All the websites listed in this article are .com’s unless another domain is listed. (Example:

Pandora.com)

MUSIC: Pandora, Spotify, 8tracks, Deezer, fizy, Grooveshark, Last.fm, Mflow, MOG,

Pandora, Qriocity, Rhapsody, Slacker, Thumb-play, we7, WiMP and Zune are among the

streaming music sources. This list is probably not complete as things change practically daily.
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Pandora and Rhapsody are among the best known. Pandora is free but you get ads. There is

a paid version ($3.50/month) without ads. You get to choose your artist or genre or composer

or song and they deliver that or similar material to you. It is also available on many

automobiles and on tablets and smart phones as well as computers. For details of how each of

these services work and if you need to download a player, and whether they are free or pay I

refer you to their websites. Which, if any, you choose, is a very personal choice: what works for

you. Your computer will understand the format as all send MP3's and other common music

formats. Only Microsoft uses Windows Media Audio files for music but Zune (Microsoft’s

service) streams in MP3, AAC, MP4, mp4, mov, and WMA formats.

TV Programs and Movies: some commercial, some not. Zune, Netflix, Atom.com, blip.tv,

Break.com, Citytv.com.co, DaCast, EngageMedia, Flickr, iFilm, imeem, Metacafe, MoboVivo,

Multiply, MyVideo, Openfilm, Phanfare, Qik, Revver, RuTube, ScienceStage, sevenload,

showmedo, Tudou, Twango, U-verse, Veoh, Vahoo Video, Youku, and YouTube are among

sources for streaming video on-line.

I want to emphasize the commercial ones with commercial TV programs and movies and

those most used: Netflix, Hulu, and HuluPlus, and Amazon. You can also get TV in Win7 with

Media Center set for TV. Some networks are increasingly moving you to their site for the TV

programs (CBS on Hulu for example). Disney-ABC, NBC, and Fox own Hulu. Netflix is an

independent company which began renting DVD’s by mail and more recently began streaming.

You may be aware of the upset when they tried to separate the DVD service and the streaming

and charge more for streaming.

Hulu free gives you the latest 5 episodes of your favorite TV programs. For $7.99 monthly

(HuluPlus) you get the full season and sometimes more than one season. Movies are the

current ones and many older ones (Some services claim 10,000.) You get to choose. It’s not the

manager of your local Cineplex choosing. Once released on DVD they become generally

available if the service has negotiated rights to the flick or to the studio’s films. There clearly

is conflict between Netflix, Hulu and Amazon and other streaming services and the studios.

The movie companies are terrified about what happened to the music industry and only

grudgingly cooperate.

How do you get the signal from your router/wireless access point to your TV and what

equipment do you need? The simplest way is by registering your device with the service using

your Xbox, Playstation 3, Wii, Blu-ray DVD player, smart phone, or other internet/wireless

enabled device. Yes, you can use a computer and the HDMI output on your computer to the

HDMI input on your TV. You can also use an Ethernet cable network or route the signal

through a power line network. If you want to see other internet material on your big screen

TV (using it as a giant monitor), you need a “smart” TV. Remember the signals on the internet

are different from those on your cable/satellite/or over the air TV station, and a “brain” is

needed for the conversion automatically. Some Smart TV’s are wireless enabled, and Sony and

Samsung make wireless adapters for their TV’s. I presume other manufacturers do so also.

Amazon now has two forms of video access: Amazon Instant Videos and (Amazon) Prime

Instant Video. The former provides rental or purchase of videos which may be watched by

streaming or downloaded to your computer and watched later. Prime Instant Video provides

unlimited streaming of thousands of movies and TV shows without commercials if you are a

Prime ($79/yr) member. Not all videos in the Amazon Instant Video store are in the Prime

instant video catalog. Videos in the Prime Instant Video catalog can only be watched by

streaming and are not available for downloading. There is a great deal of information on the

Amazon site. Start on the upper left side of the home page where it says “Instant Video” and

on the following page on the right side below “Start Your one Month Free Trial” is “Help and
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FAQ’s.” Click there and on the following page in the middle in blue is a link “Amazon Instant

Video” and then on the next page in the middle is “Watching Videos” which gives several

choices depending on whether you will be using a computer or an internet connected device.

When you (tired yet?) go to your choice, you will get details of connection methods and

possibilities.

The easiest way to connect is the HDMI cable from computer to TV and there are adapters

to convert the business end of the HDMI to composite cables (3 cables, Red and white audio

and yellow video) if your set requires those connectors.

Roku, a streaming device, available for about $50 from roku.com has comprehensive

connection directions. The Roku XD/S has HDMI and component output for high fidelity video

on new and older televisions.

Nintendo has just announced that Hulu and HuluPlus can now be streamed on the Wii (

they previously just had Netflix) but you will need to download an “app” from their website.

Redbox and Verizon have announced they will start a streaming service, no details yet.

I will mention ITunes since everyone knows them. They stream radio stations, podcasts,

and ITunes University (lectures from many U’s; there is a huge list on their site) but not TV

programs or movies. Those are rentals. If you rent a TV program or movie from them, it is

downloaded to your machine (not streamed). You have it for 30 days, but once you start

watching you only have 48 hours (TV) or 24 hours (movie) to watch it. From iTunes.com,

download iTunes 10.5 for Mac/PC.

Important to remember: not all services carry all content (programs, movies), and not all

devices other than computers (and Roku?) will display all content. Check their websites before

plunging in. Apple TV and Google TV seem to be especially limited but other devices may be

also.

The bottom line is that the power of computers, the capacity of operating systems, and the

capabilities of the networks have improved to the point that streaming has become possible

for almost everyone.
From the March 2012 issue of The ICON – Newsletter of the Interactive Computer Owners Network in

Missouri.

Help’s Half Hour Notes
April 10, 2012

Brighton Library

by Jan Rothfuss

A
pple was founded on April 1, 1976. The company was formed by Steve Jobs, his friend Steve

Wozniak, and a man named Ronald Wayne, who had worked with Jobs at Atari. The

partners planned to produce and sell Apple personal computer kits, hand-assembled by

Wozniak. They weren’t personal computers as we think of them today, but were rather just

motherboards. 

The company was incorporated the following January, but this time without Wayne; he had lost

his nerve after a couple of weeks, and sold his 10 percent share back to Jobs and Wozniak for a

little over $2,000. Had he held onto it, that share would be worth around $22 billion USD today.

Wayne said later that he did not regret selling the stock — he said, “I made the best decision

with the information available to me at the time.” He went into the stamp and rare coin
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Q: A member got an email with a long URL inside of it, pointing to a document up in the

clouds. How can he download the file and not just view it? 

A: Perhaps you can right click and there is a “save as” option. You first have to know which

“cloud” it is.  

Q: Is it safe to put items in to the clouds? 

A: Do not put anything related to your business there. It is also part of the policy that they can

use/review your content. 

Q:  member is running an old Dell Dimension 3100. It is not recognizing a CD. After it is ‘fixed’,

it runs for a little while but then dies again. 

A: It could be a mechanical issue. You may want to replace the drive/burner to solve the

problem as they are fairly inexpensive. 

Q: Firefox is now updated to version 11.0. If you have it installed, it generally updates itself.

A: If you go to Help => About, you can check whether there are any pending updates available.

Q: When will Windows 8 be available? 

A: The plan is for this Fall. There is a 3 gb file download if you want to try out the beta version.

Q: Google now has virtual glasses. It allows you to phone someone, access the Internet

through Google voice.  

Q: Anyone have a tablet? 

A: No one raised their hand. Tablets are getting to be a bit more like an extension of your

telephone. Developers like them as they are fairly safe. 

The Lighter Side

An Ode to the Spelling Chequer
Prays the Lord for the spelling chequer

That came with our pea sea! 

Mecca mistake and it puts you rite

Its so easy to ewes, you sea. 

I never used to no, was it e before eye? 

(Four sometimes its eye before e.) 

But now I’ve discovered the quay to success

It’s as simple as won, too, free! 

Sew watt if you lose a letter or two, 

The whirled won’t come two an end! 

Can’t you sea? It’s as plane as the knows on yore face

S. Chequer’s my very best friend

I’ve always had trubble with letters that double

“Is it one or to S’s?” I’d wine

But now, as I’ve tolled you this chequer is grate

And its hi thyme you got won, like mine. 

–Janet E. Byford


